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 computerجدول مفردات مادة 

 المفردات الأسبوع

1 

introduction to Computer: Concepts of Hardwar and Software with their 
components; Concept of computing, Data and Information; Connecting 
input/output devices, and peripherals to CPU. 

2 
computer Components: Computer Portion             
Hardware Parts, I/O Units, Memory Types 

3 
 

Basic PU Components, Computer Ports, Personal computer, Personal Computer 
(Features and Types) 

4 

 
operating System and Graphical User Interface GUI (count): 
operating System basics of common operating System the user interface using 
mouse Techniques. 

5 

operating System and Graphical User Interface GUI (count): use common icons, 
status bar using Menu and Menu-selection, Concept of folders and Directories, 
Opening and closing of different Windows; Creatin Short cut 

6 

. word Processing: Word Processing Basics features; Word of Processing opening 
and closing of documents; Text creation and manipulation formatting text and 
paragraphs using templates for document creation. 

                  
  

7 
word Processing: (count): creating and managing tables, utilizing styles and themes. 
spell check and Grammer tools, using headers and folders. 

8 
spread Sheet: introduction to spreadsheet software. Creating and formatting 
worksheet sorting and filtering data using formulas and function 

 

9 
spread Sheet: (count;)using formulas and function using pivot tables for data 
analysis data validation and error checking, data visualization: creating charts and 
Graphs.  

10 

Presentation Software: Basics of presentation software; overview of popular 
Preparation tools Creating a new Presentation; using templates and formatting 
text and image transition and animation. 
Effects.                                                                                                                

11 

Presentation Software(count):- using speaker notes and timers. advanced features. 
Hyperlinks and action buttons troubleshooting common Presentation issues, future 
trends in Presentation technology.   

12 
introduction to Internet and Web Browsers: computer networks Basic; LAN, WAN; 

Concept of Internet and its Applications; connecting to internet  

13 
  introduction to Internet and Web Browsers count: world   
Wide Web; Web Browsing software's, Search Engines; Understanding URL; 
Domain name; IP address.  

14 

communications and Emails: Basics of electronic mail; Getting an email account; 
Sending and receiving emails; Accessing sent emails; Using mails; Document 
collaboration. 

15 

introduction to cloud computing and services: - 

definition of could computing and is concept, workspace), google dos, google 
sheet, google drive, google meet. 



 )الهدف العام(:  computer ....الهدف من دراسة مادة 

 الى:  firstللصف..   computerتهدف دراسة مادة    

1.  Acquire basic computer skills and office applications . 

2.  Learn to use Microsoft Word word processing programs to prepare administrative reports and 

records. Master spreadsheets such as Excel to manage and analyze financial data, statistics, and 

timelines... and prepare reports . 

3. Use presentation programs... These programs aim to help users organize their thoughts and 

present information visually. PowerPoint helps convert dense text and complex data into visual 

slides and is used in multiple fields 

4. Learn about computer components, the concepts of hardware and software, information 

representation, the concept of data processing, and information technology applications . 

 

 الفئة المستهدفة:  

  Healthcare Management Technologies Department     / قسم firstطلبة الصف      

 

 

 

 

 

 -:التقنيات التربوية المستخدمة   

1. whiteboard and markers 

2. interactive whiteboard 

3. data protector Data Show 

4. computer devices Laptop 

5. poster presentation 

 

 

 

 

 

 

 

 

 

 

 



 الأسبوع الأول     

 learning objective   -:الهدف التعليمي

1. The goal is for the student to be able to define the concept of a computer and to 

define data and information . 

2 .  The student will explain the importance of computers in daily life . 
3  . The student will classify types of computers, such as desktop computers, laptops, 

        tablets, and  servers. 
  4  .The student will list the main components of a computer . 
5  . The student will distinguish between the functions of each of the physical   

       components . 
  6  . The student will explain the relationship between the physical components and  
        how they work together in a computer system. 
 

Theoretical and practical (3 hours) 
 

   المستخدمة:الأنشطة 
1. Interactive classroom activities 

2. Brainstorming questions 
3.  Group activities (if required) 
4.  Homework 
5  .Online homework (it is preferable to create online classrooms to integrate in-person  
    learning with online learning, in accordance with modern teaching and learning trends) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



   -المحاضرة: عنوان 
 

introductions to Computer: Concepts of Hardware and Software with their components; Concept 

of computing, Data and Information 
herals to CPUperip , anddevicesConnecting input/output  

 
(First and second week)   

In today's world, we use computers for all our tasks. Our day-to-day activities: paying bills, buying 
groceries, using social media, seeking entertainment, working from home, communicating with a 
friend, etc., can all be done using a computer. So it is important not only to know how to use a 
computer, but also to understand the components of a computer and what they do.   
This topic explains all concepts related to computer in detail, from origin to end. The idea of computer 
literacy is also discussed, which includes the definition and functions of a computer. You learn about 
the components of a computer, the concept of hardware and software, representation of 
data/information, the concept of data processing and applications of IECT. 

 
What is a Computer? 
A computer is an electronic device that accepts data from the user, processes it, produces results, 
displays them to the users, and stores the results for future usage.  

Data is a collection of unorganized facts & figures and does not provide any further information 
regarding patterns, context, etc. Hence data means "unstructured facts and figures".  

Information is a structured data i.e. organized meaningful and processed data. To process the data 
and convert into information, a computer is used. 

IECT stands for Information Electronics and Communication Technology. Th applications                            

                                                                                                                                             of IECT are       

                                                                                                                                  as follows:  

• E-governance  

• Multimedia and Entertainment  

Functions of Computers 

 
A computer performs the following functions:        

  

Receiving Input  

Data is fed into computer through various input devices like keyboard, mouse, digital pens, etc. Input can 
also be fed through devices like CD-ROM, pen drive, scanner, etc.  

  

Processing the information  

Operations on the input data are carried out based on the instructions provided in the programs.   
  

Storing the information  

After processing, the information gets stored in the primary or secondary storage area.  



Producing output  

The processed information and other details are communicated to the outside world through output 
devices like monitor, printer, etc.  

Components of Computer System  

Computer systems consist of three components as shown in below image: Central Processing 

Unit, Input devices and Output devices. Input devices provide data input to processor, 
which processes data and generates useful information that’s displayed to the user through output 
devices. This is stored in computer’s memory.   

 

The Central Processing Unit (CPU) is called “the brain of computer” as it controls operation of all parts of 
computer. It consists of two components: Arithmetic Logic Unit (ALU), and Control Unit.  

  

Arithmetic Logic Unit (ALU)  

Data entered into computer is sent to RAM, from where it is then sent to ALU, where rest of data 
processing takes place. All types of processing, such as comparisons, decision making and processing of 
non-numeric information takes place here and once again data is moved to RAM.                                  

Control Unit  

As name indicates, this part of CPU extracts instructions, performs execution, maintains and directs 
operations of entire system.                                                 

Functions of Control Unit  

Control unit performs following functions:                                                                               

• It controls all activities of computer  

• Supervises flow of data within CPU  

• Directs flow of data within CPU  

• Transfers data to Arithmetic and Logic Unit  

 

Central 
Processing 

 
 



• Transfers results to memory  

• Fetches results from memory to output devices  

Memory Unit  

This is unit in which data and instructions given to computer as well as results given by computer are 
stored. Unit of memory is “Byte”.                                                                     

1 Byte = 8 Bits                                                    

Input Devices – Keyboard and Mouse   

 

Input devices help to get input or data from user. Some of input devices are:               

 

 
 
 
 
 
 
 
 
 
 
 
 

  

  

Other Input Devices  

There are few other input devices which help to feed data to the computer. They are as    follows:  

Input 
Devices  

Characteristics  Image  

  

  

Trackballs  

  

  

A trackball is also a 
pointing device 

which will work like a 
mouse. It is mainly 

used for gaming and 
entertainment 

purpose.  

  

 

  

Name  Characteristics  Image  

  

Keyboard  

The keyboard was 

first peripheral 

device to be used 

with computers.  

It helps to input text 

and numbers into 

computer.  

It consists of 104 keys 
and 12 functional 

keys.  

  

 

  

  

  

  

Mouse  

  

A mouse is an input 
device which is also 

called as pointing 
device because it 

helps to point data 
on screen.   

It also helps to select, 
highlight content and 

drag-drop controls.  

  

 

  

  



  

  

  

Digital 

Pens  

  

A digital pen is 
another input device 
which is mostly used 

with tablets, PDAs, 
etc.   

A digital pen is also 
called as a Stylus 

which helps to write 
or draw data over 

pad.  

  

 

  

  

  

  

Scanners  

  

Scanners transform 

printed material and 

photographs into a 

digital 

representation.  

 After scanning of 
printed material, 

page is represented 
in memory as an 

array of pixels.  

  

 

  

  

  

  

Barcode 

readers  

  

  
Barcode reader helps 

to read information 
which is printed as 

bars in back of goods 
or items.  

Barcode readers are 
most widely used 

input devices which 
we can see in most 
of products in our 

day to day life.  

  

  

 

  



  

  

Voice 

Recognition 

System  

  

  
Voice recognition 

system interprets or 
receives dictation or 

spoken commands to 
authorize user.  

  

 

  

  

  

  

Touch 

screen  

  
A touch screen is an 

input device which 
uses sensors to sense 
touch of users to get 

input data.  

  

 
   

Output Devices  

Output devices help to display output to user. Some of output devices are:               
  

Output 
Devices  

Characteristics  Image  

  

Monitor  

A monitor is most 

common type of 

output device.   

It is also called as 
“Visual Display Unit”.  

The inputs given by 

keyboard or any 

other input devices 

will get displayed on 

monitor.   

Cathode Ray Tube 
(CRT) and Flat panel 
display monitors are 

commonly used 
monitors.   

  

 

 reliable and faster 
and also offer high 

quality compared to 
impact printers.   

 

Sound 

Systems  

  

  

Sound systems are 
output devices which 

are used to get 
multimedia content 

  

  



such as voice, music, 
etc., as output. Some 
of examples of sound 

systems are 
speakers, 

headphones, and 
microphones.  

 

   

  

Computer Memory   

Computer memory refers to storage area where data is stored. It is of two types:              

Primary Memory        Secondary Memory                                                                         

Primary Memory  

Primary memory is the main memory of computer present in motherboard. Primary memory is of two 
types as shown in the image below.                         

  

 

Random Access Memory  

RAM is referred as temporary memory, in which, information stored is lost once computer is turned off. 
It is a volatile memory. Instructions written in this memory can be modified; hence it is also known as 

programmable memory. The two types of RAM are Static RAM (faster and costlier) and Dynamic 

RAM.                                         
 

Functions of RAM are as follows:                                                                            

• It stores data till it gets processed.  

• It stores instructions for data processing.  

• It acts as a working space where data processing takes place and intermediate results are stored.  

• It stores processed data/results before it is sent to output devices.  

Read Only Memory  

ROM is referred as permanent memory, in which information stored is available even if computer is 
turned off. Instructions stored in this memory can only be read and cannot be modified. Mostly ROM has 
a start-up instruction which is executed every time when computer is switched on. Types of ROM are 
PROM (Programmable Read Only Memory), EPROM (Erasable PROM), EEPROM (Electrically Erasable 
PROM) and flash memory.   

 
The below table jots down the major differences between RAM and ROM:                  

S. No  RAM  ROM  



1  It is volatile 
memory.  

It is non-volatile memory.  

2  The contents 
are temporary; 

data is lost 
when 

electricity 
supply is lost.  

The contents are permanent; data is not 
lost even when power is switched off.  

3  Available in 
small storage 

capacity.  

Available in high storage capacity.  

4  Processing 
speed is high.  

Processing speed is low.  

5  User-defined 
programs can 

be stored.  

Generally, operating system supporting 
programs can be stored.  

6  Cost is very 
high.  

Cost effective.  

7  It is of two 
types, SRAM 
and DRAM.  

It comes in different types such as PROM, 
EPROM, EEPROM and flash memory.   

Secondary Memory  

Sometimes when data to be processed is large, it cannot fit in primary memory as it is limited, in such 
cases, we use supplement memory or secondary memory. Secondary memory helps to store information 
permanently and is non-volatile. Examples of secondary storage memory are compact disk, floppy disk, 
pen drive, external hard drive, etc.  

Concept of Hardware and Software   

The concept of hardware and software is explained in detail below:             

Hardware  

 The term hardware refers to mechanical device that makes up computer.      Computer hardware 
consists of interconnected electronic devices that we can use to control computer’s operation, input and 

output. Examples of hardware are CPU, keyboard, mouse, hard disk, etc.  
  

Computer hardware is a collection of several components working together. Some parts are essential 
and others are added advantages. Computer hardware is made up of CPU and peripherals.  

Software  

A set of instructions that drives computer to do stipulated tasks is called a program. Software 
instructions are programmed in a computer language, translated into machine language, and executed 
by computer. Software can be categorized into two types:  

• System software   

• Application software  



System Software  

System software operates directly on hardware devices of computer. It provides a platform to run an 
application. It provides and supports user functionality. Examples of system software include operating 
systems such as Windows, Linux, Unix, etc.  

Application Software  

  An application software is designed for benefit of users to perform one or more tasks.     Examples of 
application software include Microsoft Word, Excel, PowerPoint, Oracle, etc.  

 

Differences between Software and Hardware are sorted out below:                     

S. 

No  
Soft

war
e  

Hardware  

1  It is a 
collection of 
programs to 

bring 
computer 
hardware 

system into 
operation.  

It includes physical components of 
computer system.  

2  It includes 
numbers, 

alphabets, 
alphanumeric 

symbols, 
identifiers, 
keywords, 

etc.  

It consists of electronic 
components like ICs, diodes, 

registers, crystals, boards, 
insulators, etc.  

3  Software 
products 

evolve by 
adding new 
features to 

existing 
programs to 

support 
hardware.  

Hardware design is based on 
architectural decisions to make it 

work over a range of 
environmental conditions and 

time.   

4  It will vary as 
per computer 

and its built-in 
functions and 
programming 

language.  

It is mostly constructed for all 
types of computer systems.  

5  It is designed 
and 

developed by 
experienced 

The hardware can understand only 
low-level language or machine 

language.  



 

 

 

Personal computer has advanced a 

lot in a short period of time, and 

much of the advancement is due to 

ongoing progresses in operating 

systems. Evolution of operating 

systems had made PCs easier to use 

and understand, flexible. 

 

*** Computers classification

Computers can be generally classified 

by size and power as follows, though 

there is Considerable overlap: 

 • Personal computer: A small, single-user computer based on a microprocessor. In addition 

to the microprocessor, a personal computer has a keyboard for entering data, a monitor for 

displaying information, and a storage device for saving data 

. • workstation : A powerful, single-user computer. A workstation is like a personal computer, 

but it has a more powerful microprocessor and a higher-quality monitor 

. • minicomputer : A multi-user computer capable of supporting from 10 to hundreds of users 

simultaneously. 

 • mainframe : A powerful multi-user computer capable of supporting many hundreds or 

thousands of users simultaneously 

. • supercomputer : An extremely fast computer that can perform hundreds of millions of 

instructions per second. Laptop and Smartphone Computers LAPTOP: A laptop is a battery or 

AC-powered personal computer that can be easily carried and used in a variety of locations. 

Many laptops are designed to 

 

 

 

 

 

 third work)) 

programmers 
in high-level 

language.  

6  It is 
represented 
in any high-

level language 
such as BASIC, 

COBOL, C, 
C++, JAVA, 

etc.  

The hardware works only on binary 

codes 1’s and 0’s.  

  

7  The software is 
categorized as 

operating 
system, 
utilities, 

language 
processor, 

application 
software, etc.  

The hardware consists of input 
devices, output devices, memory, 

etc.  



Basic PU Components, Computer Ports, Personal computer, Personal Computer (Features 

and Types) 

 

What are Computer Ports? 

The computer ports are physical docking points of a computer that facilitate users to connect required 

external devices to the computer or computer network. A connection point that acts as an interface 

between the computer and external devices like a mouse, printer, modem, etc. is called a port. Ports are of 

two types − 

• Internal port − It connects the motherboard to internal devices like hard disk drives, CD drives, 

internal modems, etc. 

• External port − It connects the motherboard to external devices like modem, mouse, printer, flash 

drives, etc. 

Expansion of a computer network or interconnection between multiple peripheral devices was possible 

through computer ports where network connections start and end. Generally, Ports are computer hardware 

which are software-based means they are operated by a software program like an operating system. 

Generally, ports are docking points through which information flows from a program to the computer or 

over the Internet. 

Working Principles of Computer Ports 

Computer ports are tangible or virtual connectors on a computer or device that provide connectivity to 

external devices, peripherals, or networks. They enable the exchange of information between the 

computer and external devices. 

Characteristics of Ports 

A port has the following characteristics − 

• External devices are connected to a computer using cables and ports. 

• Ports are slots on the motherboard into which a cable of the external device is plugged in. 

• Examples of external devices attached via ports are the mouse, keyboard, monitor, microphone, 

speakers, etc. 

 

Let us now discuss a few important types of ports − 

Serial Port 

In the past, it was used to connect different devices which includes modems, mice, and printers; however, 

due to the prominence of USB, it has become completely obsolete in modern computers. Serial ports 

transmit data sequentially means one bit at a time. To do the same, these ports require one cable to 

transmit 8 bits. However, this makes slower communication. Serial ports are usually having 9-pin or 25-

pin male connectors. They are also known as COM (communication) ports or RS323C ports. 



 

Overall, serial ports act as a port which is − 

• Used for external modems and older computer mice 

• Two versions: 9-pin, 25 pin model 

• Data travels at 115 kilobits per second 

Parallel Ports 

Another older port that is primarily used for connecting printers and other devices that are used for 

external storage; like serial ports, parallel ports are rarely found on modern computers. Parallel ports can 

send or receive 8 bits or 1 byte at a time. Parallel ports come in the form of 25-pin female pins and are 

used to connect printers, scanners, external hard disk drives, etc. 

 
• Used for scanners and printers 

• Also called a printer port 

• 25 pin model 

• IEEE 1284-compliant Centronics port 

PS/2 Port 

PS/2 stands for Personal System/2. It is a female 6-pin port standard that connects to the male mini-DIN 

cable. PS/2 was introduced by IBM to connect Input/output peripherals to personal computers. Used to 

create a connection between keyboards and mice on computers that is of an earlier generation. PS/2 ports 

have a circular shape, and they are colored purple for keyboards and green for mice. 

This port is now mostly obsolete, though some systems compatible with IBM may have this port. 

 
• Used for old computer keyboard and mouse 

• Also called the mouse port 

• Most of the old computers provide two PS/2 ports, each for the mouse and keyboard 

• IEEE 1284-compliant Centronics port 

Universal Serial Bus (or USB) Port 

USB stands for Universal Serial Bus. It is the industry standard for short-distance digital data connection. 

It is one of the most popular ports for connecting accessories, including external hard drives, printers, 

mice, keyboards, and more. There are different types and sizes of USB ports, such as micro-USB, USB-

A, USB-B, and USB-C.USB port is a standardized port to connect a variety of devices like printers, 

cameras, keyboards, speakers, etc. 



Overall, a USB port acts as a port which is − 

• It can connect all kinds of external USB devices such as external hard disks, printers, scanners, 

mice, keyboards, etc. 

• It was introduced in 1997. 

• Most of the computers provide two USB ports as a minimum. 

• Data travels at 12 megabits per second. 

• USB-compliant devices can get power from a USB port. 

VGA (Video Graphics Array) Port 

Before the development of DVI, HDMI and DisplayPort, VGA was in use; it's an analogue interface 

between a computer and the monitor. It's a display standard developed by IBM in 1987; VGA replaced the 

existing digital CGA and EGA interfaces with a smaller resolution and fewer colours. A standard VGA 

works on 16-color displays with a refresh rate of 60 Hz and a resolution of 640 × 480. There are 256 

colours shown if the resolution is lowered to 320 x 200. Nowadays, it's not in use, older PCs and displays 

have this video port. Digital connections like HDMI and DisplayPort are replacing it. 

Overall, a VGA port acts as a port that − 

• Connects monitor to a computer's video card. 

• It has 15 holes. 

• Similar to the serial port connector. However, the serial port connector has pins, VGA port has 

holes. 

 

 

 

Power Connector 

For the sole purpose of supplying power to a device, power connectors are devices that allow an electrical 

current to pass through them. 

 

It is possible for a computer or other electronic device to charge its battery and get power from a wall 

outlet through its power port. Since desktop computers don't have batteries, they can't be turned on 

without a power cord plugged into the power port. The battery in a device like a laptop can work even if 

nothing is plugged into the power port as long as the battery is charged. 

Overall, a power connectors port acts as a port which is a 

• Three-pronged plug. 

• Connects to the computer's power cable that plugs into a power bar or wall socket. 

 

Firewire Port 



An interface with a high data transfer rate is generally utilized for connecting digital camcorders, external 

hard drives, and other multimedia equipment. USB and Thunderbolt have mostly superseded it. Hence, a 

FireWire is a high-speed computer data transfer interface that is used to connect personal computers, 

audio and video devices, as well as other professional and consumer electronic products. 

 

Overall, a FireWire port acts as a port which is a 

• Transfers large amounts of data at a very fast speed. 

• Connects camcorders and video equipment to the computer. 

• Data travels at 400 to 800 megabits per second. 

• Invented by Apple. 

• It has three variants: 4-Pin FireWire 400 connector, 6-Pin FireWire 400 connector, and 9-Pin 

FireWire 800 connector. 

 

 

 

Ethernet Port 

An Ethernet port also known as a jack or socket is a port used to access the internet on commuter. Enables 

wired network connections, which are normally used for connecting computers to routers, switches and 

modems that allow Internet access. It's like computer network equipment that Ethernet cables plug into. 

The main goal of this port is to connect wired network hardware in an Ethernet LAN, MAN, or wide 

WAN. 

 
• Connects to a network and high-speed Internet. 

• Connects the network cable to a computer. 

• This port resides on an Ethernet Card. 

• Data travels at 10 megabits to 1000 megabits per second depending upon the network bandwidth. 

SD Card Slot 

SD card slots are frequent functionality ports generally seen on desktop computers and laptops. 

 

These slots enable users to insert SD memory cards, which are typically utilized in digital cameras and 

other portable devices. 

 



reliable. This chapter is the study of primary operating systems currently used in personal 

computers and network servers, and their basic features.  

This topic presents a broad survey of concepts and terminologies related to operating systems 

like: Basics of operating system, user interface, basic settings of operating system, file & 

directory management, and types of files.   

Unit of Measurements 

Storage measurements: The basic unit used in computer data storage is called a bit (binary 

digit). Computers use these little bits, which are composed of ones and zeros, to do things 

and talk to other computers. All your files, for instance, are kept in the computer as binary 

files and translated into words and pictures by the software (which is also ones and zeros). 

This two number system, is called a “binary number system” since it has only two numbers in 

it. The decimal number system in contrast has ten unique digits, zero through nine. 

Computer Storage units 

Bit BIT 0 or 1 

Kilobyte KB 1024 bytes 

   

Megabyte M

B 

1024 kilobytes 

Gigabyte GB 1024 

megabytes 

Terabyte TB 1024 gigabytes 

Size example 



• 1 bit - answer to an yes/no question 

• 1 byte - a number from 0 to 255. 

• 90 bytes: enough to store a typical line of text from a book. 

• 4 KB: about one page of text. 

• 120 KB: the text of a typical pocket book. 

• 3 MB - a three minute song (128k bitrate) 

• 650-900 MB - an CD-ROM 

• 1 GB -114 minutes of uncompressed CD-quality audio at 1.4 Mbit/s 

• 8-16 GB - size of a normal flash drive 

Speed measurement: The speed of Central Processing Unit (CPU) is measured by Hertz (Hz), 

Which represent a CPU cycle. The speed of CPU is known as Computer Speed. 

 

CPU SPEED MEASURES 

1 hertz 

or Hz 

1 cycle per second 



1 MHz 1 million cycles per second or 

1000 Hz 

1 GHz 1 billion cycles per second or 

1000 MHz 



*Computers classification 

Computers can be generally classified by size and power as follows, though there is 

Considerable overlap: 

• Personal computer: A small, single-user computer based on a microprocessor. In addition 

to the microprocessor, a personal computer has a keyboard for entering data, a monitor 

for displaying information, and a storage device for saving data. 

• workstation : A powerful, single-user computer. A workstation is like a personal 

computer, but it has a more powerful microprocessor and a higher-quality monitor. 

• minicomputer : A multi-user computer capable of supporting from 10 to hundreds of 

users simultaneously. 

• mainframe : A powerful multi-user computer capable of supporting many hundreds or 

thousands of users simultaneously. 

• supercomputer : An extremely fast computer that can perform hundreds of millions of 

instructions per second. 

Laptop and Smartphone Computers 

LAPTOP: A laptop is a battery or AC-powered personal computer that can be easily carried 

and used in a variety of locations. Many laptops are designed to have all of the functionality 

of a desktop computer, which means they can generally run the same software and open the 

same types of files. However, some laptops, such as netbooks, sacrifice some functionality in 

order to be even more portable. 

Netbook: A netbook is a type of laptop that is designed to be even more portable. Netbooks 

are often cheaper than laptops or desktops. They are generally less powerful than other types 



of computers, but they provide enough power for email and internet access, which is where 

the name "netbook" comes from. 

Mobile Device: A mobile device is basically any handheld computer. It is designed to be 

extremely portable, often fitting in the palm of your hand or in your pocket. Some mobile 

devices are more powerful, and they allow you to do many of the same things you can do 

with a desktop or laptop computer. These include tablet computers, e-readers, and 

smartphone. 

 
Tablet Computers: Like laptops, tablet computers are designed to be portable. However, they 

provide a very different computing experience. The most obvious difference is that tablet 

computers don't have keyboards or touchpads. Instead, the entire screen is touch-sensitive, 

allowing you to type on a virtual keyboard and use your finger as a mouse pointer. Tablet 

computers are mostly designed for consuming media, and they are optimized for tasks like 

web browsing, watching videos, reading e-books, and playing games. For many people, a 

"regular" computer like a desktop or laptop is still needed in order to use some programs. 

However, the convenience of a tablet computer means that it may be ideal as a second 

computer. 

Smartphones: A smartphone is a powerful mobile phone that is designed to run a variety of 

applications in addition to phone service. They are basically small tablet computers, and they 

can be used for web browsing, watching videos, reading e-books, playing games and more.
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     )      (    fourth and fifth week 

operating System and Graphical User Interface GUI (count): 
operating System basics of common operating System the user interface using mouse  

Techniques  

Basics of Operating System                                                                      

Operating System   

Operating system is a software that controls system’s hardware and interacts with user 

and application software.  

In short, an operating system is computer’s chief control program.  

Functions of Operating System  

The operating system performs the following functions:  

• It offers a user interface.  

• Loads program into computer’s memory.  

• Coordinates how program works with hardware and other software.  

• Manages how information is stored and retrieved from the disk.  

• Saves contents of file on to disk.  

• Reads contents of file from disk to memory.  

• Sends document to the printer and activates the printer.  

• Provides resources that copy or move data from one document to another, or 

from one program to another.  

• Allocates RAM among the running programs.  

• Recognizes keystrokes or mouse clicks and displays characters or graphics on the 

screen.  
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Types of Operating System  

There are four types of operating systems:  

• Real-time operating system  

• Single-User/Single-Tasking operating system  

• Single-User/Multitasking operating system  

• Multi-User/Multitasking operating system  

Real-time operating system  

Real-time operating system is designed to run real-time applications. It can be both 

single- and multi-tasking. Examples include Abbasi, AMX RTOS, etc.  

 

Advantages  

• It works very fast.  

• It is time saving, as it need not be loaded from memory.  

• Since it is very small, it occupies less space in memory.  

Single-User/Single-Tasking OS  

An operating system that allows a single user to perform only one task at a time is 

called a Single-User Single-Tasking Operating System. Functions like printing a 

document, downloading images, etc., can be performed only one at a time. Examples 

include MSDOS, Palm OS, etc.  

Advantages  

• This operating system occupies less space in memory.  

Disadvantages  

• It can perform only a single task at a time.  

Single-User/Multitasking OS  

An operating system that allows a single user to perform more than one task at a time 

is called Single-User Multitasking Operating System. Examples include Microsoft 

Windows and Macintosh OS.  
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Advantages  

• It is time saving as it performs multiple tasks at a time yielding high productivity.  

Disadvantages  

• This operating system is highly complex and occupies more space.  

Multiuser/Multitasking OS  

It is an operating system that permits several users to utilize the programs that are 

concurrently running on a single network server. The single network server is termed 

as “Terminal server”. “Terminal client” is a software that supports user sessions. 

Examples include UNIX, MVS, etc.  

  

Advantages  

• It is highly productive as it performs multiple tasks at a time.  

• It is time saving as we don’t have to make changes in many desktops, instead 

can make changes only to the server.  

Disadvantages  

 If the connection to the server is broken, user cannot perform any task on the 

client as it is connected to that server. 

Basics of Popular Operating Systems (Windows, LINUX)  

 

We shall discuss about the basic of Operating Systems in this section:  
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Windows Operating System  

Windows operating system is developed by Microsoft Corporation. It provides 

Graphical User Interface (GUI), multitasking capability to users. It also provides virtual 

memory management and several peripheral devices. According to statistics, about 

90% of computers have migrated to Windows operating system.  

Linux Operating System  

Linux is a multitasking operating system that supports various users and numerous 

tasks. It is open source, i.e., code for Linux is available for free of cost. Linux can run 

on any computer and support almost any type of application. Linux uses command-

line interface. It also supports windows-based GUI environment, called “shells”. The 

most popular Linux vendors are Red Hat and Novell. Some of the Linux versions 

include Ubuntu, Fedora, Linux Mint, etc. 

 

operating System and Graphical User Interface GUI (count): use common icons, 

selection, Concept of folders and Directories, -status bar using Menu and Menu

Opening and closing of different Windows; Creatin Short cut 

User Interface   

 

While working with a computer, we use a set of items on screen called “user 

interface”. In simple terms, it acts as an interface between user and software 

application or program. It accepts inputs from input devices like keyboard, mouse and 

displays output to computer monitor.  
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Task Bar   

• Task bar appears at bottom of the Windows desktop.  

• It is used to launch and manage programs.  

• It also shows icons of currently running programs.   

 

Components of task bar  

A task bar consists of following three components:     

• Start menu  

• Quick launch bar   Notification area  

  

Start Menu  

Start menu contains shortcuts for launching programs and opening folders on 
computer.  

  

Quick Launch Bar  

It is a special section at left end of task bar where we can add icons to quickly start 

programs.  
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Notification Area  

Notification area displays icons for system and program features. It also displays system 

volume and a clock.  

  

Icons   

A small pictogram displayed on the desktop is called an “icon”. It represents links to 

the resources on PC or network. Icons actually are tiny graphical symbols that 

represent programs, files, folders, printers, documents, etc. Icons are also called as 

“shortcuts”. Using mouse pointer, we can click the icon and then corresponding 

resource will be launched.   

Start Menu   

Start menu consists of shortcuts for launching programs and folders. It also consists a 

list of most recently used documents and provides ‘search’ option and supports ‘help’ 

feature.  

Launching Start Menu  

• Start menu can be set in motion by clicking (  Win) windows button on a 

keyboard.  
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• It can also be launched by pressing CTRL+ESC on a keyboard.   

• By clicking on the visual Start button, it can be launched.  

 

Running an Application   

 

The operating system offers an interface between programs and user, as well as 

programs and other computer resources such as memory, printer and other programs.  

  

  

Process  

• Step 1: Application sends request to operating system.  

• Step 2: On encountering the request from an application, operating system 

sends a response to requested service.  

Operating System Simple Setting   

We will learn different settings in Operating System:                              

Changing System Date and Time   

We can set system date and time in three ways given below:            

Step 1: One way is to just click the clock on task bar and perform Step 4 and 

Step 5.                                                     
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Step 2: Another alternate way is to go to the “Control Panel”  from Start 

menu and select “Clock, Language and     Region”, and select “Date 

and Time” and perform Step 4 and Step 

5.                                                                 
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Step 3: In the window displayed, select “Change date and 

time”                                                                                                           

  
Step 4: Set corresponding date and time, and finally press “OK” button.  
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Changing Display Properties   

Display properties include Desktop Background, Text, Window Color, Sounds, 

Screensaver, etc. To change these display properties, we have to perform the 

following steps.  

Step 1: Right click on desktop and select “Personalize” from displaying 
options.  

  
Step 2: From the displayed window, select desired action, like changing the 

background/themes/resolution, and press “Save Changes” 

button.                                                                             
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Step 3: Alternate way is to go to the “Control Panel” from Start menu and 

select “Appearance and Personalization” and select display you want 

from the listed options and save changes.  
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To Add or Remove a Windows Component  

In order to add or remove Windows component, follow the below steps:  

Step 1: Type “add or remove programs” in the search box and select “Add or 

Remove Programs” under control panel and follow Step 3 and Step 

4.                                                     
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Step 2: Alternate way is to select “Control Panel” from start menu and select 

“Uninstall a Program” from “Program” and follow Step 3 and Step 4.  

  

  

  

Step 3: Click “Turn Windows features on or off” on left side of programs 

and features window.  
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Step 4: From window displayed, add or remove the program you want, and click 

“OK” button.                                                                   

  

Changing Mouse Properties   

Properties of the mouse can be changed by following steps below:  

Step 1: Go to “Control Panel” from start menu.              

  

  

  

Step 2: Select “Hardware and Sound” and select “Device and 

Printers” from the listed options.                                                  
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Step 3: Click on “Mouse” under Devices and Printers, and change any of 

the following properties and “Apply” changes            .  

➢ Button - Changes primary and secondary button and double-click speed.  

➢ Pointer - Changes image seen during specific window operation.  

➢ Pointer Options - Changes precision of pointer, speed and visibility of 

long or short pointer.   

➢ Wheels - Changes horizontal and vertical scrolling.  

➢ Hardware - Helps to view properties of mouse.  

➢ Device Setting - Required only if we are using the laptop.  

  

  

Adding and Removing Printers  

To add or remove printers we have to execute following steps:  

Step 1: Go to “Control Panel” from start menu.            
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Step 2: Select “Hardware and Sound” and select “Device and 

Printers” from the listed options                                                .  

   

  

  

Step 3: Now under “Devices and Printers”, we can add a printer using “Add 

a Printer” tab at top of the window.             

  

Step 4: To remove a printer, “Right Click” by placing the cursor    on printer you 

want to remove, and select “Remove Device”     from popped up menu. 

File and Directory Management   

Here, we will learn the concepts of File and Directory Management:  

File  

File is nothing but a collection of information. The information can be of numbers, 
characters, graphs, images, etc. Every file should be stored under a unique name for 

its future reference. Every file should be saved along with an 
extension                                                            
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Directory Management  

Directory is a place/area/location where a set of file(s) will be stored. It is a folder 

which contains details about files, file size and time when they are created and last 

modified.  

The different types of directories are discussed below:  

Root Directory  

Root Directory is created when we start formatting the disk and start putting files on 

it. In this, we can create new directories called “sub-directories”. Root directory is the 

highest level directory and is seen when booting a system.  

 

Subdirectory  

Subdirectory is a directory inside root directory, in turn, it can have another sub-

directory in it.                                                               
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Sith and seventh week)    ) 

. word Processing: Word Processing Basics features; 
Word of Processing opening and closing of documents; 
Text creation and manipulation formatting text and 
paragraphs using templates for document creation. 

                  
  

word Processing: (count): creating and managing tables, 
utilizing styles and themes. spell check and Grammer 
tools, using headers and folders. 

 

Microsoft Word 
 is a popular word processing software. It helps in arranging written text in a proper 
format and giving it a systematic look. This formatted look facilitates easier reading. It 
provides spell-check options, formatting functions like cut-copy-paste, and spots 
grammatical errors on a real-time basis. It also helps in saving and  

                                                                 storing documents.         
It’s also used to add images, preview the complete text before printing it; organize 
the data into lists and then summarize, compare and present the data graphically. It 
allows the header and footer to display descriptive information, and to produce 
personalized letters through mail. This software is used to create, format and edit any 
document. It allows us to share the resources such as clip arts, drawing tools, etc. 
available to all office programs,   
In this chapter, you will learn about Concepts related to MS Word in detail. You will 
know about Word Processing Basics, Opening and Closing the Document, Text 
Creation and Manipulation, Formatting Text, and Table Manipulation. 

 

  

Basics of Word Processing   

 

Word processor is used to manipulate text documents. It is an application program that 
creates web pages, letters, and reports.   
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Opening Word Processing Package  

 

Word processing package is mostly used in offices on microcomputers. To open a new 

document, click on “Start” button and go to “All Programs” and click on “Microsoft 

Word”.  
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Menu Bar  

A menu bar is located below the title bar. A menu bar is an application window to 
furnish application or window-specific menus. Menu bar has File Menu along with 

Home, Insert, Design, Page Layout, References, Mailings, Review, And View.  

File - It has options such as, Save, Save As, Open a New Document, Print, etc.  

Home - It has icons to change Font Size, Style, Alignment, Borders, etc.  

Insert - It has icons to insert Table, Shapes, Chart, Pictures, Screenshot, Header, Footer, 

etc.  

Design - It has icons to change Themes, Colors, Fonts, Effects, Page Borders, etc.  

Page Layout - It has icons to set Margins, Orientation, Size, Breaks, Indent etc.  

References - It has icons to Add Text, Update A Table, Insert Footnote, Index.  

Mailings - It has icons to start Mail Merge, Add Labels, Envelopes, etc.  

Review - It has icons for Spelling And Grammar Check, Thesaurus, Word Count, 

Comments, Tracking, etc.  

View - It has icons like: Zoom, Print Layout, Switch Windows, Split, etc.  
You may use a particular menu to give an instruction to the software. Place mouse 

over menu option and click left mouse button to open drop-down menu. You can use 
left and right arrows on your keyboard to move left and right across menu bar option. 

Up and down arrow keys can be used to scroll drop-down menu.  
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Using Help menu  

Help menu → By clicking this button, you can get help for any information you 
need. Help button is located at the top right corner of window. It looks like a question 

mark, “?”. Shortcut key for help menu is F1.  

  

Using Icons below Menu Bar  

The bar located below menu bar is the toolbar. Toolbar provides shortcuts to menu 
commands. It has icons which represent commonly used functions. 

→ to save a file. 

→ to print current file. 

→ to check for page orientation before the document gets printed. 

→ to check spelling, grammar and writing style. 

→ to remove selected word or sentence from the document. 

→ to copiy selected word or sentence from the document. 

→ to paste content from the clipboard. 

→ to reverse the last command. Shortcut key for undo is “Ctrl + Z” 

→ to redo last command. Shortcut key for Redo is “Ctrl + 

Y” → to set borders to content. 

→to insert a single table or more tables as required into the document. 

→to change number of columns in the document. 

→ to change font color. 

→ to change font style. 
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Opening and Closing Documents 

 

Word automatically starts with a blank page. For opening a new file, click on “New”. 

 To close a document, click “X” in the upper right corner of window. 

 
 

Opening the document 

To open an already existing document, follow the below steps                              

• Click on the “File → Open”. 

• From the window opened, select a file you want to open and double click on it or 

just right-click and select “open”.  Shortcut key is Ctrl + O. 
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Save and Save As 

After finishing our work, we must save the document permanently, as it is useful for future 
reference. 

• As RAM is a temporary storage memory, we must save our file on the hard disk.  

 To save a document, go to “File” menu and select “Save” option  

 Shortcut key is “Ctrl + S”. 

• Then the file gets saved under a default name. 
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Save As option is used to rename a file.                                                                

• If you want to save your document in another location with same or different name, 

you can use “Save As” option. 

• The shortcut key for Save As is “F12”. 

• To use Save As option in a document, follow the below steps: 

✓ Go to File menu 

✓ Click Save As 

✓ Select the drive where you want to save the document. 

✓ Then type any Name in the File Name box at the bottom of dialog box. ✓ 

Then click Save option. 
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Page Setup 

• Parameters defined by the user help in determining how a printed page will appear. 

• Those parameters include everything from size, margins, page orientation, and 

quality of print. Page setup options are usually available in “Page Layout” menu. 

• Unless you open an existing document, Word always opens a blank document using 

the present formatting defaults. 

• You can use these defaults or customize the setting for features such as Margins, 

Paper Size, And Layout Through The Page Setup Option. 

• To change settings, click page setup menu. 

• Margins icon will be displayed in page setup window. 

• Click on any of the up or down arrows to increase the top, bottom, left or right 

margins as per your requirement. 

• You can also set the position of header and footer. 

• To change the orientation of a page, choose either landscape or portrait. 

• By clicking the respective icons, you can also make paper source and layout changes 

under layout, you can also set margins for headers and footers. 

 

Print Preview 

 

• This option is used to view the page or make adjustments before any document 

gets printed. 
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• By using print preview, you can discover any errors that may exist in the document 

or fix the layout before printing, which can save ink/toner and paper. 

• For printing, you may specify the number of copies you want and the pages you 

want. 

• Shortcut key for printing is “Alt + F and Press W and then V” or Ctrl + P. 

 
 

 

Printing of Documents 

• To print a document, choose File → print. 

• Here all the pages of a document will be selected by default. 
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• To print specific pages that are not in sequence, use comma (,) to separate page 

numbers. 

• To print a selected text inside the document, highlight the area in document that you 

want to print and choose File → Print from menu bar. 

• When print window opens, click on radio button to select printer and click ok. 

• To print multiple pages on a page, choose the number of pages to print on one page 

from the ‘Settings’ of print window. Then click ok. 

• Shortcut key is “Alt + F → Press W and then P”. 

 

 

 

 

Text Creation and Manipulation 

• There are several kinds of word documents, such as blank documents that starts 

from scratch, templates, web pages, reports, etc. 

• A template is helpful in reusing format of a document. 

• Manipulation of text includes cut, copy, paste, or moving text to any location. 
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Document Creation 

• Click start → All programs → Microsoft Office → Click 

Microsoft Office 2013 → Word 2013. Word will open a blank 

document. 

• Another way to create a document is to choose File → New from the 

menu bar and select the document type. Press Ctrl + N on the 

keyboard. This menu allows you to open a blank document, a template or an 

existing document. 

• To enter text in blank document, just start typing. The blinking I-Beam 

(Cursor), positioned at the top of window, will show exactly where your text 

begins. As you type, word will automatically wrap text to the next line. If you 

have finished typing on a line and would like to move to the next blank line, 

press enter. 
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Editing Text 

• Modifying existing text in an old document or entering new text in an existing 

document is known as editing of the text. 

• Editing text can be done by three options: “Find”, “Replace”, “Select”. 

1. Find → To find a word in a document. 

2. Replace → To replace existing word with a new word. 

3. Select → To select a word or sentence. 

 



 

      53  
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Text Selection 

• Document is built up by typing one character at a time. While editing and formatting, 

words, lines, paragraphs, or sometimes the whole document can be selected. 

• Once a part of text in a document is selected, changes can be made to that text. 

• The selected text can be moved, copied and changed to italic, bold or underline. 

• Font and color of the text can also be changed. 

• Both mouse and keyboard can be used to select the text. 

• Using mouse, text can be selected by either double-clicking or by clicking and 

dragging.  

• Using keyboard, text can be selected by pressing the shift key + arrow keys.   To 

select the entire page, use shortcut, “Ctrl + A”.  
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Cut, Copy and Paste  

 

 In this section, we shall learn how to use cut, copy and paste functions in Word.  

Cut  

• Deleting unnecessary data from a document is called cutting.  

• In Microsoft Word, you can cut text from one area of a document and paste that 

text anywhere in the document.  

• After you cut the text, it gets stored in the clipboard.  

• If you want to cut any text or word from a document, it is advisable to highlight the 

word first.  

• To cut, Right Click→Cut.   

• The shortcut key is “Ctrl + X”.  
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Copy  

• Copy option can be used when we need to retype the same text as it reduces 

time and effort.   

• By using copy option, you can copy the text from one location to another.  

• Information stored on the clipboard stays there until new information is either cut 

or copied.  

• Each time you use cut or copy, you replace the old information on the clipboard 

with the information you just cut or copied.  

• To copy, Right Click → Copy.   

• The shortcut key is “Ctrl + C”.  
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Paste  

• Select your text and then copy it..  

• Use mouse to move the cursor to desired position to paste the copied text.  

• Click paste to insert the copied text in its new place.   

• You can paste clipboard information as often as you like.  

• To paste, Right Click→ Paste.    The shortcut key is “Ctrl + V”.  

  

Font and Size selection  

• To change size of font in the file or document, first select the text you want to 

change.   

• If you want to select all the text from document, click “Ctrl + A”   From 

home menu, click font size option.  

• You can also change style of the font using “Font Style” feature.  

  

Alignment of Text  

• You can align text to Left, Right, Center and Justify.  

• By default, the content always appears to the left side of document.  

• Alignment can be done by using mouse or keyboard shortcuts.  

• For center alignment, click to “center align” icon or use shortcut key “Ctrl + E”.  

• For right alignment, click to “right align” icon or use shortcut key “Ctrl + R”.  

• For left alignment, click to “left align” icon or use shortcut key “Ctrl + L”  

• If you click on “justify” it will align with respect to both left and right margins. The 

shortcut key used here is “Ctrl + J”.  
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Formatting Text  

• A font refers to set of characteristics that characters of Word support.   
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• The process of formatting a document includes controlling the appearance of text 

and layout of text on page.  

• Character formatting includes settings that control attributes of individual text 

character such as Fonts, Font Size And Type Style.   

  

Paragraph Indenting  

• Indentation improves the readability of document.  

• Options for indentation includes Left, Right, Center And Justify.   

 

Bullets and Numbering  

 
• Bullets and numbering are used to list important points and messages.  

• When a document is in the form of long paragraphs, reader may not be able to 

quickly notice important points or message. Bullets and numbering emphasize lists of 

things.  

• To list points or topics in a document, bullets are used.   

• Numbered list works well for directions or other points.   

• While typing a document, details should be given step-by-step for easy 

understanding. MS Word’s feature “Bullets and Numbering” fulfils this 

purpose.  

• You can either use the word defaults for bullets and numbers or can define your own 

list.  

  

  

  

Changing Case  

We usually type content of documents in different forms such as Lower case, Upper case, 
Sentence case, etc.  

• Sentence Case → First character of the sentence is capitalized.  
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• Lower Case → Entire selected text will change to small letters.  

• Upper Case → Entire selected text will change to capital letters.  

• Title Case → First character of each word begins with a capital letter.  

• Toggle Case → It changes lowercase to uppercase and vice-versa.  

  

Table Manipulation  

 

Manipulation of table includes drawing a table, changing cell width and height, 
alignment of text in the cell, deletion/insertion of rows and columns, and borders and 
shading.  

Draw Table  

Tables can be easily inserted at any point of the document. A table is a simple way to 
arrange lengthy lists. You can use tables to format all parts of your documents into 

rows and columns. Rows and columns can be added or deleted either at the 
beginning, end or in the middle of table. For inserting a table, simply click on “Tables” 

icon on Insert menu. Tables can be formatted to any size, and number of rows and 
columns can be added as per requirement. Table formatting toolbar contains 

numerous icons which can be used for different functions related to tables. Spin 
arrows in the columns and rows help to select a row or a column.   
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Changing cell width and height  

• When we create a table, all columns may have equal width or may have different 

widths depending upon the usage.  

• If you want to change column widths, “Ruler” or table properties from the table 

menu can be used.  

• By using “Ruler” you may change the row border and size.  

  

  

  

Alignment of Text in a cell  

• Select one or more cells in table, and click table layout menu.  

• Under Alignment, click Align, and then select corresponding option.  
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Delete/Insertion of Row and Column  

For inserting rows and columns into an existing table, position cursor either before or 
after the spot where you want to insert.  

Right-click mouse button to →Insert/Delete.  
  

  

Inserting a column to the right  

After finishing the table, in case you need to insert a column on the right-hand side of a 
particular column in the table, you may use the following steps:   

1. Place cursor where you want to insert a column in the table.  

2. Right-click on mouse button → Insert column to right.  

  

Insert rows above  

After finishing the table, in case you want to insert a row in the top of a particular row in 
table you may use the following steps:   

1. Place cursor where you want to insert a row in the table.  

2. Right-click on the mouse button→ Insert row above.  

  

  

Insert rows below  

After finishing the table, in case you want to insert a row in the bottom of a particular 
row in the table, you may use the following steps:   

1. Place cursor where you want to insert a row in the table.  

2. Right-click mouse button → Insert row below.  
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Delete Column  

If you want to delete particular columns in a table, use the following steps:  

1. Select the column which you want to delete.  

2. Right-click mouse button→ delete cells → delete column. 

 

  

Delete Rows  

If you want to delete particular rows in a table, use the following steps:  

1. Select the row which you want to delete.  

2. Right-click Mouse Button→ Delete Cells → Delete Row.  

   

  

  

  

Border and Shading  

• Borders and shading is used to decorate a text.  

• Select the text for which you need to apply borders or shading.  

• Click home menu.  

• Move to borders and shading icon.  

• From the open window, select border style, width you want and click ok button.   
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Opening a Spread Sheet   

To open a spreadsheet, we have to click on “Start” button and go to “All Programs” 

and click on “Excel”.  
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Opening an existing worksheet  

To open an existing document, go to file menu, File → Open → Recent 

workbooks.  
  

 
  

Renaming a work sheet  

Every sheet is given a name by default as sheet 1, sheet 2, etc. It is necessary to customize 
the name according to user reference. To change this name, right click on sheet tab that is to 

be renamed. Name in the sheet tab gets highlighted and can be edited.  
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Organization of worksheet   

Spreadsheet is made up of number of books. Each book contains number of columns and 
rows. Rows and columns are made of many cells. The cell pointer in cell A1 is as shown the 

below:  

  

Cell Address  

Cell is a small unit in the worksheet which is used to store data. A cell is refered by its 
column and row number.  

Example  

Cell B followed by row 6 is called as B6. Each cell in worksheet has a unique address. Using 
arrow keys in the keyboard, we can move from one cell to another cell.  
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Title bar  

Title bar displays the name of excel worksheet. It appears at the top of all window programs. 
By default, excel opens with the name Book 1.  

  

Menu bar  

Menu bar is located directly below the title bar. It displays a list of menus that can be used to 
give commands to excel. Clicking on a menu bar displays a drop down menu of icons. You 
can move across the menu bar and scroll down menus with your mouse by highlighting one 
of the menu items and using arrow keys on your keyboard.  

• File - It has options such as: save, save as, open a new document, print, etc.  

• Home - It has icons to change font size, style, alignment, borders, etc.  

• Insert - It has icons to insert table, chart, pictures, screenshot, header, footer, etc.  

• Page Layout - It has icons to set margins, orientation, size, breaks, indent, etc.  

• Formulas - It has insert function, auto sum, date and time, lookup and reference, 

etc.  

• Data - It has icons to import data from web, from access, refresh all, from other 

sources, etc.  

• Review - It has icons for spelling and grammar check, thesaurus, word count, etc.  

• View - It has icons to zoom, print layout, switch windows, split, etc.  
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Formula bar  

Cell content can be edited directly in the cells or in formula bar. If cell contains a formula, it 
will be displayed here. If there is no formula, then content of the cell is displayed. Formula 

bar allows you to view, enter and delete data in a selected cell.  
  

  

  

 

Mathematical formula appears in the formula bar when a cell that includes a formula is 
selected in the worksheet. In the below example, formula to calculate average grades is in 

cell E5. When E5 is selected, formula appears in the formula bar.  

  

Printing a Spread Sheet  

Printing is creating a hard copy of any content. A spreadsheet can be printed by selecting 

File → Print option. Shortcut to print is “Ctrl + P”.  
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Saving Workbooks   

After typing our content in excel worksheet, we must save the worksheet for future use.  

Shortcut key to save is “Ctrl + S”. The process of saving consists of following steps:  

1. Click File menu.  

2. Click Save option from sub menu.  

 

  

  

  

  

Manipulation of Cells   

Manipulation of cells is entering and modifying the contents of the cells.   

Entering Text, Numbers and Dates   

In this topic, we are going to learn how to enter text.  

1. Place cursor in the cell where you want to enter text.  

2. Type the contents or texts in that cell.  
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Numbers  

Num Lock (to “on” or “off” Number keypad) can be used to make data entry easy. To enter 
numeric values in the spreadsheet, follow the below steps:  

1. Open a new worksheet.  

2. Enter the number you would like to add.  

3. Fill the complete numeric data in different cells.  

4. Press Esc when you have completed entering your data.  

  

Dates   

Returns the sequential serial number that represents a particular date. Cell format remains 
normal before function gets entered in the cell. Result is formatted as a date, once the 

function gets executed.  

Syntax  

DATE (year, month, date)  

Example  

=DATE (2018,4,18)  
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Output 

18/4/2018  

  

Creating Text, Number and Date Series   

Here, we will look into creating text, number and data series:  

Creating Text Series  

• Select the cell that contains starting text.  

• Then drag fill handle (+) over the cell where you want to fill text.  
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Creating Number Series  

• Open a new excel sheet.  

• Select the cell that contains starting number.  

• Then drag fill handle (+) over the cell where you want to fill number.  

  

  

  

  

Example  
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Creating Dates Series  

• Returns the sequential serial number that represents a particular date.  

• Select the cell that contains starting date.  

• Then drag fill handle (+) over the cell where you want to fill date.  
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Editing Worksheet Data   

 

Modifying or adding text or using cut, copy, paste operations to an existing document is 
known as editing.   

• To edit data in a worksheet, first open the worksheet by clicking on File → Open.  

• Next, move cursor to the cell, which you want to edit.  

• Note that content of the cell is displayed in formula bar as well.  

• As you perform any operation, it is visible in the formula bar. Cut  

• Deleting unnecessary data from the cell is called cutting.  

• In Microsoft Excel, you can cut text from one area of a worksheet and save or paste 

that text anywhere.  

• When you cut the text, it is stored on clipboard.  

• If you want to cut any text or content from worksheet, first select the text or content 

which you want to cut.  To cut, Right Click → Cut.   

• The shortcut key is “Ctrl + X”.  
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Copy  

Instead of retyping the same text, Copy function is used which reduces time and effort. By 

using copy option, you can copy the text from one location to another. Information stored 
on clipboard stays there until new information is either cut or copied. When you execute cut 

or copy, you replace old information on the clipboard with whatever you have just cut or 
copied.  

  To copy the content, Right Click → 

Copy.    Shortcut key is “Ctrl + C”.  

  

  

  

  

Paste  

• Select your text to highlight it.  

• First copy the text.  

• Use mouse to move the cursor to desired position to paste the copied text.  

• Click paste to insert the copied text in its new place.   

• You can paste clipboard information as often as you like.  

• To paste, Right Click → Paste.    Shortcut key is “Ctrl + V”.  
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Inserting and Deleting Rows, and Column   

• To insert and delete rows and columns in an existing table, position the 

cursor either before/after/above the spot where you want the 

insertion/deletion to be.  

• Right Click → Insert/Delete.  

Insert column to the left  

After finishing our table, in case we want to insert a column on the left hand side of a 
particular column. We may use the following steps.  

1. Place the cursor where you want to insert a column in the table.  

2. Right click → Insert column to left.  
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Insert column to the right  

After finishing our table, in case, we want to insert a column on the right hand side of a 
particular column, follow below steps:   

1. Place the cursor where you want to insert a column into the table.  

2. Right click → Insert column to right.  
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Rows above  

 After finishing the table, in case we want to insert a row on top of a particular row,   
follow below steps:  

1. Place cursor where you want to insert a row into the table.  

2. Right click → Insert row above.  

  

Delete Rows  

If you want to delete particular rows in a table, use the following steps:  

1. Select cells or rows you want to delete.  

2. Right click → Delete → Table Rows.  

Delete column  

If you want to delete a particular column in a table, use the following steps:  

1. Select column or cells you want to delete.  

2. Right click → Delete → Table Columns.  

  

Changing Cell Height and Width   

When we create a table, all the columns may have equal column width or different widths. If 
you want to change the row height, simply select the row and right click. Then select the 
Row Height option. 
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Function and Charts  

We shall learn how to use functions and charts in Microsoft Excel:  

Using Formulas   

You can use formulas to perform basic mathematical calculations, such as addition, 
subtraction, multiplication, and division of numbers. The following examples demonstrate 
how to use formulas to carry out mathematical calculations.  

Addition   

Addition helps to add two or more values. By using “=SUM(cell1+cell2)” formula, we can 
calculate the sum of values.  

Examples  

• Open a new worksheet.  

• Move the cursor to cell A1.  

• Write one value in cell A1 and another value in cell B1.  

• Write “=SUM(A1+B1)” in cell C1 which will automatically get displayed in formula 

bar.  

• Press Enter.  

• Note that cell A1 has been added to cell B1 and the result is shown in cell C1.  

Subtraction  

Subtraction helps to subtract two or more values. By using “=SUM(cell1-cell2)” formula, we 
can calculate the difference between the values of cell 1 and cell 2.  

Example  

• Open a new worksheet.  

• Move the cursor to cell A1.  

• Write one value in cell A1 and another value in cell B1.  

• Write “=SUM(A1-B1)” in cell C1 which will automatically get displayed in the formula 

bar.  

• Press Enter.  

• Note that cell B1 has been subtracted from cell A1 and the result is shown in cell C1.  

Multiplication  

Multiplication helps to multiply two or more values. By using “=SUM(cell1*cell2)” formula, 

we can calculate multiplication. Examples  

• Open a new worksheet.  

• Move the cursor to cell A1.  

• Write one value in cell A1 and another value in cell B1.  

• Write “=SUM(A1*B1)” in cell C1 which will automatically get displayed in the formula 

bar.  
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• Press Enter.  

• Note that cell A1 has been multiplied to cell B1 and the result is shown in cell C1.  

Division  

• Division helps to divide one value by another value.  

• By using “=SUM(cell1/cell2)”, formula we can perform division.  

•  

Examples  

• Open a new worksheet.  

• Move the cursor to cell A1.  

• Write one value in A1 and another value in B1.  

• Write “=SUM(A1/B1)” in cell C1 which will automatically get displayed in the formula 

bar.  

• Press Enter.  

• Note that cell A1 is divided by cell B1 and the result is shown in cell C1. 

Function    

• Microsoft Excel has a set of prewritten functions to perform a specific task.   

• When using a function, remember the following steps:   

1. Use an equal (=) sign to begin a function.  

2. Specify the function name.  

3. Enclose arguments within parenthesis.  

4. Use a comma to separate arguments.  

5. Here is an example of a function,  =POWER(number, power) or  

=POWER(cell1,cell2)  

Chart   

 

A chart is a graphical representation of worksheet data. Charts can make data interesting, 
attractive and easy to read and evaluate. They can also help you to analyze and compare 
data.  

Creating a Chart  

The easiest way to create charts in excel is by using the chart wizard. Chart wizard icon 
appears on the insert menu. Chart wizard is a program which consists of different types of 
charts; it helps user through the process of creation of charts. Icons or symbols present at 
the side of chart help to add or remove elements to the chart, change chart style and add a 
filter to the chart. After completing a chart, you can still make changes to it or just start from 
the beginning.  
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Getting Started with Chart Wizard  

• The first stage in using chart wizard is to have a table of data.  

• In excel, open a new worksheet, and enter data.  

• Then you must select range of cells that you need in the chart.  

• For example, with cursor in the top-left cell of the table (A1), select table by clicking 

and dragging cursor to the bottom right-hand cell (B7).  

  

• Click Insert menu and select chart option.  

• From chart types, select the type of chart that you would like to use.  

• Excel has different types of Charts such as line charts, pie chart, area chart, pivot 

chart, etc.  

• The selection of chart type is usually driven by the data, although there are no strict 

rules for determining the chart type you should use.  

• But you should use the one which displays your data and conveys your message in 

the simplest way possible.  

  

Procedure  

• Click Start → All programs → MS-Office → MS-Excel.  

• Insert a table in the worksheet.  

• Select Insert → Chart icon.  

• Select column option from chart type.  

• In the title bar, Click on chart title box and type, population . 

•  
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 (Ten and Eleventh week) 
Presentation Software: Basics of presentation software; Creating Presentation; 
Preparation and Presentation of Slides; Slide Show; eking printouts Of presentation / 
handouts. 

Microsoft PowerPoint is one of the powerful tools of MS-Office, which helps in creating and 
designing presentations. PowerPoint Presentation is an array of slides that convey 
information to people in an attractive manner. 

In this chapter, we are going to discuss in detail about the applications of presentation using 
Microsoft PowerPoint, opening and saving a presentation, creating presentation using 
templates and a  blank presentation, entering and editing text, inserting and deleting slides 
in a presentation, preparing slides, inserting word table or an excel worksheet and other 
objects, adding clip arts, resizing and scaling of objects, providing aesthetics by enhancing 
text presentation, working with colors and line style, adding movie and sound, header and 
footer, viewing a presentation, choosing a set up for presentation, printing slides and 
handouts, Slide Show, running a Slide Show, transition and slide timings, automating a Slide 
Show. 

Using Powerpoint   

 

You can create a new presentation by choosing File → New → Presentation.  
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Opening an existing PowerPoint presentation  

To open an existing PowerPoint, select File → Open → Recent Presentations → and select 
the presentation you want to open.  
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Saving a presentation       

• To save a presentation, click on “File” menu and choose “Save” option.  

• Every presentation will be saved by default as presentation1, presentation2, 

presentation3 and so on.  

• To change the default save location, select Save As → Computer → Browse.  

• Click on the browse option to see a window where you can select desired location to 

save the file.  

• To rename the presentation, simply add desired name in the ‘File Name’ tag. Click on 

‘Save’.  

• MS PowerPoint saves files with the extension (.ppt).    
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Creation of Presentation  

A presentation is made up of number of slides that are displayed in a sequence. Each slide 
has sub-topics and different content related to the given topic.  

Creating a presentation using a template  

A template is a presentation that has a pre-defined theme and format. Templates are 
readily available design structures. There are two types of templates: design and content 

templates. A design template automatically gives final look of your presentation. The 
content template is used to include text and graphics.   

To create a presentation using template, select File → New → and select desired template.  
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Creating a Blank Presentation  

 A blank presentation has no pre-formatted designs or colors. Every required element 

in the presentation has to be created or inserted specifically by the user.  To create a 
blank presentation, select File → New → Blank presentation.  

  

   

  
  

  

Entering and editing text  

• To enter text in a slide, insert a new slide.  

• A slide has two sections:  

1. Click to add the title.  
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2. Click to add the subtitle.  

• In ‘Click to add title’ box, delete the text and include desired heading.  

• In ‘Click to add subtitle’ box, delete the text and add sub heading.  

• Editing text refers to the changing of text size, style, color, indentation, etc.  

 

Inserting and deleting slides in a presentation  

To create a new slide, follow the below steps:   

o Go to Home → New Slide or  o Insert → New 

Slide or  o Right Click over the slide → select 

New Slide.   

 Shortcut key to create a new slide is Ctrl + M.  

  

Computer Concepts   
          

  

Computer Concepts  — 

  

Application of  

Presentations 
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To delete a slide, go to the corresponding slide and right click on it to select Delete slide 
option.  

  

  

Customizing a Presentation  

• Customizing a presentation can be done using Custom Slide Show options.   

• PowerPoint allows you to start Slide Show from the current slide and also provides 

option to hide some slides.  

• To customize a Slide Show, Choose Slide Show → Custom Slide Show → New.  

• Under existing slides, select slides you want to add to your Slide Show.  
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• Hold down shift to select a range of slides, or Ctrl to select non continuous slides.  

• Here you can change the order of the slides in your Custom Slide Show by dragging 

and dropping the slides under selected slides.  

• Click ok button.  
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Preparation of slides  

 

The below topics explain the preparation of slides:  

Inserting a word table or an excel worksheet   

• We can insert a word table in PowerPoint using “Insert” menu.  

• To insert the table, first create a new slide.   

• Then click on “Insert” menu and select the “Table” icon. Select the number of rows 

and columns.   

• Press Enter.  
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Inserting an excel worksheet  

• We can insert an excel worksheet in PowerPoint using “Insert” menu.  

• First, create a new slide.  

• To insert a new excel file inside the presentation, click on insert menu and select 

Object icon → Create New → Choose the object type as Microsoft Excel sheet → 

click Ok.  

• To insert an existing excel file, select Create from file → Browse.  

• Finally, select the excel document you wish to insert and press enter.  
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Adding clip art pictures   

• Clip art is a cartoon-like icon or representation.  

• Select Insert → Online pictures.  

• In the dialog box, enter category and select the picture you want to insert.  

• Click on Insert button.  
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Inserting other objects  

• You can insert existing objects in a presentation by clicking Object icon in the insert 

menu.  

• Select Create from file option and then select Browse button.  

• Select the file you want to insert and click Ok button.  

• If you want to link the file, select the link check box.  

• To display the file as an icon, checkmark ‘Display as icon’ check box and click Ok 

button  
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Resizing and scaling an object  

First we will learn how to resize an object below:  

• To resize an object in presentation mode, select the object, then click and drag on 

resize handle around the outline.  
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• You can rotate the selected object by clicking and moving rotate handle which is 

usually present at top of the object.  
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Next, we shall leran how to scale an object:  

• To scale an object in the presentation mode, select the object.  

• You can change the height and width of the selected object by right clicking on the 

Size and Position option, and change values accordingly.  
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(Twelfth and Thirteen and fourteen  week) 

 

 
 

Internet is a global communication system that links together thousands of individual 
networks. It allows exchange of information between two or more computers on a 
network.. Thus internet helps in transfer of messages through mail, chat, video & 
audio conference, etc. It has become mandatory for day-to-day activities: bills 
payment, online shopping and surfing, tutoring, working, communicating with peers, 
etc.   
In this topic, we are going to discuss in detail about concepts like basics of computer 
networks, Local Area Network (LAN), Wide Area Network (WAN), concept of internet, 
basics of internet architecture, services on internet, World Wide Web and websites, 
communication on internet, internet services, preparing computer for internet 
access, ISPs and examples (Broadband/Dialup/Wi-Fi), internet access techniques, web 
browsing software, popular web browsing software, configuring web browser, search 
engines, popular search engines/search for content, accessing web browser, using 
favorites folder, downloading web pages and printing web pages.  

 

Basics of Computer Networks  

 

Computer network is an interconnection between two or more hosts/computers. The 
connectivity can be physical by using cables or virtual using wireless network. 
Different types of networks include LAN, WAN, MAN, etc., as shown below:  

  

introduction to Internet and Web Browsers: computer networks Basic; LAN, WAN; Concept of Internet and 
its Applications; connecting to internet; world Wide Web; Web Browsing software's, Search 

Engines; Understanding URL; Domain name; IP address. 
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Local Area Network (LAN)   

 

Local Area Network (LAN) provides data communication within shorter distance and 
connects several devices such as computers and printers. This type of network 
contains computers that are relatively closer and are physically connected with cables 
and wireless media. Any network that exists within a single building, or even a group 
of adjacent buildings, is considered as LAN. It is often used to connect separate LANs 
together so they can communicate and exchange data.  

  

Wide Area Network (WAN)   

Wide Area Network is connecting two or more LANs together, generally across a wide 
geographical area.  

Example  

A company may have its corporate headquarters and manufacturing plant located in 
one city and marketing office in another city. Each site needs resources, data and 
programs locally, but it also needs to share data with other sites. To accomplish this, 
the company can attach devices that connect over public utilities to create a WAN.  
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Metropolitan Area Network (MAN)  

Metropolitan Area Network (MAN) is an extensive network that connects numerous 
corporate LANs together. Usually MANs are not owned by sole organization. Their 
communication devices and equipment are maintained by a group or single network 
provider that sells its networking services to corporate customers. MANs often take 
the role of high-speed network that allows sharing of regional resources. MANs also 
can provide a mutual connection to other networks using a WAN link.  

  

Internet   

Internet is called the network of networks. It is a global communication system that 
links together thousands of individual networks. In other words, internet is a 
collection of interlinked computer networks, connected by copper wires, fiber-optic 
cables, wireless connections, etc. As a result, a computer can virtually connect to 
other computers in any network. These connections allow users to interchange 
messages, to communicate in real time (getting instant messages and responses), to 
share data and programs and to access limitless information.  
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Basics of Internet Architecture   

Internet architecture is a meta-network, which refers to a congregation of thousands 
of distinct networks interacting with a common protocol. In simple terms, it is 
referred as an internetwork that is connected using protocols. Protocol used is TCP/IP. 
This protocol connects any two networks that differ in hardware, software and 
design.  

Process  

TCP/IP provides end to end transmission, i.e., each and every node on one network has 
the ability to communicate with any other node on the network.   

Layers of Internet Architecture  

Internet architecture consists of three layers:  

   

IP  

In order to communicate, we need our data to be encapsulated as Internet Protocol 
(IP) packets. These IP packets travel across number of hosts in a network through 
routing to reach the destination. However IP does not support error detection and 
error recovery, and is incapable of detecting loss of packets.   

TCP  

TCP stands for “Transmission Control Protocol”. It provides end to end transmission of 
data, i.e., from source to destination. It is a very complex protocol as it supports 
recovery of lost packets.   
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Application Protocol  

Third layer in internet architecture is the application layer which has different 
protocols on which the internet services are built. Some of the examples of internet 
services include email (SMTP facilitates email feature), file transfer (FTP facilitates file 
transfer feature), etc.  

Services on Internet   

Internet acts as a carrier for numerous diverse services, each with its own distinctive 
features and purposes. 

World Wide Web and Websites   

World Wide Web is being used on internet right now. WWW is the name given to all 
resources of the internet, which you can access with a web browser. It was created as a 
method for incorporating footnotes, figures and cross-references into online documents in 
the European Particle Physics Laboratory in Geneva, Switzerland in 1989. The web makers 
wanted to make a simple method to access documents that are stored on a network, 
without searching through indexes or directories of files, and without physically copying 
documents from one computer to another before viewing them. To do this, they made a 
way to “connect” documents that were stored in different locations on a single computer, or 
different computers on a network.  

Terminologies related to WWW  

Web documents can be linked together, and are called “Hypertext”. Hypertext 
systems offer an easy approach to manage huge collections of data, which includes 
text files, pictures, sounds, movies and more. In a hypertext system, when you view a 
document or your computer screen, you can also access all the data that is linked to 
it. To support hypertext documents, web uses a protocol called “Hypertext Transfer 
Protocol” (HTTP). A hypertext document is a specially encoded file that uses 
“Hypertext Markup Language” (HTML). HTTP and Links are foundation for WWW. 

Web page is displayed in the web browser. It is a kind of word processing 
document which contains pictures, sounds and even movies along with text.  

Websites  

A collection of associated web pages is called “Website”. Websites are housed on the web 

servers. Copying a page onto a server is called “publishing” the page, which is also called 

“posting or uploading”.  
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Communication on Internet   

We shall discuss how communication happens through the use of Internet in this section: 

Email  

Electronic mail or email is one of the key parts of e-revolution which is specially 
designed for communication purpose. Once you have an email account, you can start 
sending electronic messages to anyone if you have the recipient’s email address. The 

format of an email address is “username, @ symbol, domain name 

 name@yahoo.com.”. For example: (yahoo.com, gmail.com, etc.) 

Internet Relay Chat (IRC)  

IRC is a form of real-time internet chat or synchronous conferencing. It is mainly used 
for group communication in discussion forums called channels, also allows one-to-
one communication via private message, and both chats and data transfers via Direct 
Clientto-Client protocol.  

IRC client software is available for every operating system.  

  

Video Conference  

A video conference is a telecommunication technology, which permits two or more 
people in different locations to interact via mutual video or audio transmission 
simultaneously. It is also called visual collaboration and is a type of groupware. Video 
conferencing uses telecommunication technology to bring people at different sites 
together for a meeting/conversation. This can be as simple as a conversation 
between two people in private offices, or involves several sites with more than two 
people. It can also be used to share documents, computer displayed information, 
whiteboards, etc.  

Voice Over Telephony (VOIP)  

VOIP stands for voice over IP, where IP refers to the Internet Protocol which is a base 
for all internet communications. This phenomenon began as an optional mutual voice 



 

      106  

  
 

extension to some of the instant messaging systems that took off around the year 
2000. In recent years, VOIP systems are easy to use and as convenient as a traditional 
telephone. Voice quality can still differ from call to call but is often equal to and can 
even beat the traditional calls.  

  

Instant Messaging  

Instant Messaging (IM) is a process of transferring real-time messages between users. 
It facilitates private chat room atmosphere. IM alerts users when some of their peers 
are online, so the users can start chatting with them.  

  

Chat  

Online conversations in which you are immediately able to send messages back and 
forth to one another is called “chat”.  

   

Remote access  

Internet permits computer users to connect to other computers across the world and 
to store information effortlessly. This can be done with or without any security, 
authentication and encryption technologies depending on the requirements which 
encourages work from home culture.  
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Collaboration  

Low cost and rapid sharing of ideas, knowledge and skills has made collaborative 
work easy. It is a convenient way to stay in touch with colleagues through group chat 
or private messaging. Email is also an easy way to communicate. Collaboration helps 
voice and video chat between team members and to work with shared set of 
documents.  

  

File Sharing  

• A file or document can be e-mailed to anyone as an attachment.  

• It can be uploaded to a website or FTP server, for users to download content easily.  

• It can be put into a shared location or onto a cloud for instant use by colleagues.  

  

Streaming media  

Many existing radio and television presenters provide internet “feeds” of their live 
audio and video streams. An internet-connected device, such as a computer or 

something more specific, can be used to access on-line media in much the same way, 
as television or radio receiver.  

File Transfer Protocol  

File Transfer Protocol is a network protocol which is used to transfer data from one 
computer to another over any TCP/IP based network. It helps to manipulate files on 

another computer regardless of the operating system involved.  
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Telnet  

TELNET means Telecommunication NETwork. It is a network protocol used on the 
internet or LAN connections. It helps to provide text oriented mutual communication 

using virtual terminal connection.  

  

Newsgroups  

A forum on the Usenet service for the discussion of a particular topic. Newsreader 
software is used to read newsgroups.  

  

Preparing Computer for Internet Access   

There are many ways to obtain access to the internet. The method varies according to the 
type of devices (computer, laptop, mobile) being used and type of connections offered.  

ISPs and Examples (Broadband/Dialup/Wi-Fi)   

Internet Service Provider (ISP) is the gateway to access internet. It is an organization 
that gives access to the internet. ISPs provide services for home, large industries, 
government sectors, etc. There are two types of connections:  

✓ Instant: Starts when user dials-up for connection and ends after the 

session is over.  

✓ Full-time: The connection prevails 24/7 even if the session ends.  

Broadband  

Broadband connections are considered as high speed connections, as they use modes 
that can handle several signals at once, such as fiber optics, twisted pair cables, 

coaxial cables and other technologies.  
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Dial-up  

In dial-up connection, the computer uses its modem to dial a telephone number 
given to user by an Internet Service Provider. This launches a connection between 
personal computer and ISP server. The dial-up connections are temporary, as the 

connection ends once the session gets completed.  

Wi-Fi  

Wireless LAN has become popular for use these days which is based on the 
technology called Wi-Fi (Wireless Fidelity). This uses radio waves to transmit signals 
and provides access to the internet within a short distance.  

 

Internet Access Techniques   

Internet can be accessed using following methods:  

Dial-up Connections  

In dial-up connection, computer uses its modem to dial a telephone number given to 
the user by an Internet Service Provider. This launches a connection between 

personal computer and ISP server. The process begins when the ISP server answers, 
and ceases when your computer or the server “hangs up”. This is similar to a 

traditional telephone call. Most ISP servers disconnect automatically after a certain 
period of inactivity. Once a connection is configured on the user’s computer, he/she 
can use the connection. It is secure and de-allocates unused memory automatically.  

  

Broadband Connection  

Broadband connections are considered as high speed connections, as they use modes 
that can handle several signals at once, such as fiber optics, twisted pair cables, 

coaxial cable and other technologies. Even with hundreds of users on the network, 
these connections allow large files and complex web pages to download quickly. To 

be considered as a broadband, the connection must be able to transmit data at a rate 
faster than is possible with the fastest dial-up connection. Downloading and 

uploading content will be fast.  
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Integrated Services Digital Network (ISDN) Service  

Integrated Services Digital Network (ISDN) is a digital service that simultaneously 
transmits voice & data, and controls signals over a single telephone line. ISDN service 

operates on a standard telephone line, but requires a special modem and phone 
service, which adds to the cost. An ISDN data connection can transfer data up to 

128,000 bits per second (128 Kbps). It helps to connect a PC, telephone and fax to a 
single ISDN line and use them simultaneously.  

  

Digital Subscriber Line (DSL)   

Digital Subscriber Line is similar to that of ISDN in using telephone network, but it 
uses more advanced digital signal processing and algorithms to squeeze maximum 
number of signals through telephone lines. DSL also requires changes in components 
of telephone network before it can be offered in any area. Like ISDN, DSL provides 
simultaneous data, voice and fax transmission on the same line. Several versions of 
DSL services are available for home and business use; each version provides 24/7 full-
time connection at different levels of service, speed, bandwidth and distance.  

  

 

Cable Modem Service  

Now-a-days many cable television companies use some percentage of their network’s 
bandwidth to provide internet access through prevailing cable television connections. 
Since this connection uses a special cable modem, it is called “Cable Modem Service”. 

Cable television systems transmit data via coaxial cable, which can transmit data as 
much as 100 times faster than common telephone lines. Coaxial cable allows 
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transmission via several channels simultaneously, i.e., the internet data can be 
transmitted on one channel, while audio, video and control signals are transmitted 

separately. The user can access internet and watch television concurrently, with two 
non-interfering data streams.   

  

Wireless LAN (WLAN) Connections  

Wireless LAN connections are very common these days, which are based on the 
technology that is often cited as Wi-Fi (Wireless Fidelity). The distance covered by 

WLAN is usually measured in meters rather than miles. Therefore, this is not a 
technology that connects directly to an ISP but can be used to connect to another 

LAN or device through which internet access is achieved.    

Process  

• To connect to internet, the wireless access point is connected to a wired LAN like 

any other devices, and then computers with wireless NICs can access the wired LAN.  

• “Wireless access point” is a device that acts as a hub or switch.  

• “NIC” refers to a Network Interface Card which helps to identify a computer on a 

network.  

Wireless WAN (WWAN) Connections  

A WWAN is a digital network that spans over a large geographical area. A WWAN 
accepts and transmits data using radio signals via cellular sites and satellites. At the 
switching center, the WWAN divides off into segments and then connects to either 
isolated or public network through telephone or other high speed communication 
links. The data is then linked to an organization’s existing LAN/WAN infrastructure. 
The coverage area for WWAN is normally measured in miles (kilometers) with a data 
transmission rate of 100 Mbps.   

  

  

Satellite Services  

Satellite services provide a mutual (two-way) communication between user and the 
internet. This provides a full-time connection which is used in armed forces, business, 

etc. It includes two parts:  

Transceiver - A satellite dish that is placed outdoors in direct line of sight to one of the 
several satellites in geostationary orbit.  
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Modem-like device – It is connected to a dish, placed indoors and connected to 
a LAN or computer.  

  

Web Browsing Software  

“World Wide Web” or simple “Web” is the name given to all the resources of 
internet. The special software or application program with which you can access web 
is called “Web Browser”.  

Launching a Web Browser  

Web browser is an application that is located on a computer’s disk. Once you have an 
internet connection, you can launch a web browser using the following methods:  

Method 1   

Step 1: Go to “Start Menu”.                                                                                 
  

  
Step 2: From the menu opened, click on the web browser (Mozilla, Google Chrome, 

Internet Explorer).  

  
Method 2: Alternate way is to click the shortcut icon on the taskbar or desktop.  

  

Popular Web Browsing Software   

The most popular web browsing software includes:                                                
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Google Chrome  

Google Chrome is a web browsing software developed in the year 2008 by Google 
Inc. First, it was designed for windows platform, and later adopted to Linux, 

Macintosh, and even Android. It is written using C++, Assembly, Python, and 
JavaScript.  

  

Mozilla Firefox  

Mozilla Firefox is a web browsing software developed in the year 2002 by the Mozilla 
Foundation. It is designed to work on all operating systems like Windows, Macintosh, 
Linux, and Android. It is written using C++, JavaScript, Rust, C, CSS, XUL, and XBL.  

Opera  

Opera is a web browsing software developed in the year 1995 by Opera Software. It is 
designed to work on all operating systems like Windows, Macintosh, and Linux and is 
written using C++ language.  

Internet Explorer  

Internet Explorer is a web browsing software developed in the year 1995 by 
Microsoft. It is designed to work on all operating systems like Windows, Macintosh, 
Linux and Android and is written using C++ language.  

Configuring Web Browser   

Configuring a web browser is organizing or changing the settings of the browser in a format 
presentable to the user.  

Configuring Microsoft Edge  

Configuring Microsoft Edge includes the following steps:  

Step 1: Open Microsoft Edge via shortcut icon in the task bar or “Start Menu”.  

  

Step 2: Select Microsoft Edge.  
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OR  

  
Step 3: Click “Settings” from the “Settings and more” menu.  

  
      

   

Step 3: From window opened, make changes to the settings.  
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Configuring Google Chrome  

Step 1: Open Google Chrome via icon in the 
task bar or “Start Menu”.  

  
  

Step 2: Click three vertical dots icon ( ) present at upper right corner of the window 
and go to “Settings” option from the menu displayed.  

  
  

  
Step 3: From the window opened, change settings of people, appearance, search engine, 

default browser, startup and advanced tabs.  

  

  

Search Engines   

Search Engine is an application that allows you to search for content on the web. It displays 
multiple web pages based on the content or a word you have typed.  

The most popular search engines are listed below.  

Google  

Google is the most popular and robust search engine launched in the year 1997 by 
Google Inc. It was developed by Larry Page and Sergey Brin. 
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Bing  

Bing is also a popular search engine launched by Microsoft in the year 2009. It is written 
using ASP .Net language. It is used to search web content, video, images, maps, etc.   

  

Yahoo  

Yahoo is a common search engine launched by Yahoo in the year 1995. It is a multilingual 
search engine and written using PHP language.  

  

Ask  

Ask is the most popular search engine and application for e-business which was 
launched by IAO in the year 1996. It was developed by Garrett Gruener, David 
Warthen, and Douglas Leeds.   

AOL  

America Online is a popular search engine launched in the year 1993 by AOL Inc. At 
first, it was called as control Video Corporation. The founders of AOL are Marc Seriff, 

Steve Case, and Jim Kimsey.  

   

Search for the content   

Search Engine helps to search for content on web using the following steps.  

Step 1: Launch your web browser.  
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Step 2: In “Address bar/Location”, type the search engine you want to use and press 
enter.   

Step 3: Type the content you want to search in the “search text box” and press enter.  

  
Step 4: It displays a list of web pages from which you can select corresponding 

content/web page you want.  

Accessing Web Browser   

There are several ways to access a web page like using URLs, hyperlinks, using navigating 
tools, search engine, etc.  

Using URLs  

URL refers to “Uniform Resource Locator”. Each and every website can be recognized 
using a unique address called “Uniform Resource Locator” or simply a URL. Once you 

provide URL of a specific page in address bar, web browser will find the 
corresponding page and displays result to the user.  

Using Hyperlinks  

“Hyperlink” is a part of web page that is linked to URL. Hyperlink can be text, image, 
button, arrow, etc. By clicking on a hyperlink you can move to different URL specified 

in the link from the current URL. Hyperlinked text is an underlined blue color text 
which is represented using hand symbol.  

  

Using Browsers Navigation Tools  

Web browsers offer a variety of tools to help you move around the web. These tools help 
you to quickly go back and forth through web pages.  

Back Button - Helps to move back to the previous page from current page.  
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Forward Button - Helps to move to the next page from current page.  

  
Refresh Button - Helps to refresh a current page.  

  
Close Button - Helps to close a web page.  

  

Using Bookmark  

Web browsers allow you to bookmark pages that you visit most frequently. This helps 
you to go to web page directly by selecting from a list of bookmarks instead of typing 

the URL multiple times. This is displayed as an icon with star symbol in the top right 
corner of the page.  
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Using History  

When you type any URL in address bar, the browser saves that URL automatically, 
thus creating a history list for current session. You can choose the URL you want from 
the history list instead of typing it again. 

  

 
  

Using Search Engine  

Search engine is an application that allows you to search for content on web. It 
displays multiple web pages based on the content or a word you have typed. The 

most popular search engines include Google, Yahoo, Ask, etc. Below are the steps to 
use a search engine.  

Step 1: Launch your web browser.  

  
Step 2: In “Address bar/Location”, type the search engine you want to use and press 

enter.  
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Step 3: Type the content you want to search in the “search text box” and press enter. 

  

communications and Emails: Basics of electronic ail; Getting an email account; Sending and 
receiving emails; Accessing sent emails; Using mails; Document collaboration 

 
. Co 

Communication refers to exchange of information between persons through 
internet. Internet provides a basis for communication and collaboration which can 
be done using mail, chat, skype, etc. When dealing with official matters, electronic 
mail helps in the exchange of messages text documents, web pages, audio, video, 
etc.  
In this topic, we are going to discuss in detail about basics of email, email 
addressing, configuring email client, using emails, opening email client, mailbox, 
creating and sending a new email, replying to an email message, forwarding an 
email message, sorting and searching emails, advance email features, sending 
documents by email, activating spell check, using address book, sending softcopy 
as attachment, handling spam, instant messaging and collaboration, using 
emoticons  and some of the internet etiquettes.  

Basics of E-mail   

 

Electronic mail is an application that supports interchange of information between 
two or more persons. Usually text messages are transmitted through email. Audio 

and video transfer through email depends on the browser in use. This provides a 
faster way of communication in an affordable cost.  

Advantages of E-mail  

Functionalities like attachment of documents, data files, program files, etc., can be 
enabled. This is a faster way of communication at an affordable cost.  

Disadvantages of E-mail  

If the connection to the ISP is lost, then you can’t access email. Once you send an 
mail to a recipient, you have to wait until she/he reads and replies to your mail.   
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Email Addressing   

Email address is a unique address given to the user that helps to identify the user 
while sending and receiving messages or mails.  
Username - Name that identifies any user’s mailbox  
Domain name - Represents the Internet Service Provider (ISP).  
@ Symbol - Helps to concatenate username and domain name.  
For example: user_name@domain_name  

Username - user, Domain name - gmail.com  

Configuring Email Client   

Configuring email client is setting up a client which includes the following steps:  
Step 1: Open Outlook Express using “Start Menu” or using search option under the 

start menu. Once the outlook window is open, press “Next” button at the bottom 
of the outlook express window.  

   
  

   
Step 2: Then “Add an email account” window pops up showing “Do you want to set up 

outlook to connect to an email account?”   

Check mark the ‘Yes’ radio button and hit NEXT.  
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Step 3: Then “Auto account set up” window opens showing the details of the mail 

account to be configured.  After providing corresponding details, press “Next” 
button.  

  
Step 4: The server will verify your email and then an email client will get configured 

once you press the finish button.  

  

Using E-mails   

 

The main purpose of using email is to exchange information between persons. The 

process starts with opening of client email and ends with sending and verifying 

mail to recipients. Opening Email Client   
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In order to interchange messages between people, the first step is to open or create 
an email account. Follow steps below to create an email account.  

Step 1: Go to Gmail homepage and select “More options → Create account” option.  

  
Step 2: In the window displayed, fill mandatory details and press “Next”.  

   
Step 3: Then mobile verification code will be sent to the mobile number you have 

entered, upon verification, your email account will be created.  
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Step 4: Enter details to setup the account.  

  

Mailbox: Inbox and Outbox   

 

Inbox - Inbox is an area where you can see all the received mails.  
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Outbox - Outbox is an area where the outgoing messages or messages which are in 
process of sending or which are failed to send are stored.  

Sent mail - Sent mail is an area to view all the sent or successfully delivered mails.  

  

  

Creating and sending a new E-mail  

In order to send a new text message to the user, first create or compose the message 
which includes the following steps.  

Step 1: Open your mail account by providing correct User name and Password.  

  

  
Step 2: Compose or create your message by selecting “compose” option shown in the 

window.  
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Step 3: In the window displayed, enter recipient’s address in “To” textbox and add 

“Subject” of message, then add a “Body” of the message and press “Send” button. 
Remember, the subject of the mail should be explicit and short.  

  

Replying to an E-mail message   

Replying is giving response to the received mail which includes the following steps.  
Step 1: Open an email to which you want to reply and press the “Reply” button or 

press “Shift+R” on the keyboard.  
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Step 2:  In the window displayed, enter “Body” of the mail and click “Send” button. 

The mail will be sent automatically to the corresponding person without having to re-

type the “To” address.  

  

Forwarding an E-mail message   

Forwarding is a process of resending an email message that you received from 
another email id. This option saves time as the user doesn’t have to re-type the 

same message again. It includes the following steps.  
Step 1: Open the email which you want to forward and click on “Forward” option or 

press “Shift + F” on the keyboard.  

  
Step 2: In the window displayed, enter the recipient address in “To” textbox and press 

“Send” button. The mail will be forwarded to the corresponding person.  
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Sorting and Searching emails  

Here, we will discuss about how to sort and search the existing emails:  

Sorting Emails  

Sorting helps you to arrange mails or messages in an orderly fashion. It includes the 
following steps.  

Step 1: Click arrow adjacent to “Sort by date”, a default sort option visible at the top 
of the window.  

  

  
  

Step 2: Click on any of the options from dropdown list displayed.  

• Date: Sort in chronological order as per the date of received mail.  

• Unread messages: Sort mails based on unopened messages.  

• Attachments: Sort mails based on the size of attachments.  

• Starred: Sort mails based on bookmarked or important messages.  

• Sender: Sort mails in alphabetical order based on the sender’s name.  

• Subject: Sort mails based on the subject.  



 

      129  

  
 

   

Searching Emails  

Searching email is a process of finding the desired email without going through all the 
emails.  

Step 1: Type the name, email id or key-term in the search box displayed on top of the 
window.  
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Step 2: From the list of 
displayed mails, select desired 

mail or message.   

  

Advance Email Features   

Email provides many advanced features which includes sending attachments like 
documents, videos, images, audio, etc. Apart from this, you can proofread your 

mail via feature of spell check, address book, etc.    

Sending document by E-mail   

We can communicate with a person by sending and receiving emails. To send an 
email with the document as an attachment, follow the steps below:  

Step 1: Compose a mail providing “To” address, “Subject” and “Body” of the 
message, then click on attachment( ) button and select “Attach files from 

computer” option in order to add documents to the mail.  
  

  
Step 2: In the window opened, browse document you wish to send and click “Open” 

button.  
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Step 3: Document gets uploaded and will be an attachment to that mail. Finally click 

“Send” button to send mail to the recipient.  

  

Activating Spell Check   

Activating spell check helps to avoid spelling mistakes while inserting the body of the 
mail. It includes the following steps:  

Step 1: Start composing or creating a message by providing “To” address, “Subject”, 
“Body” of the message.  
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Step 2: The second step is to “Right click” on mouse and select “Spell check” and 

from the list displayed, select “Check the spelling of text fields”, then the spell 
check feature gets activated.  
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Using Address Book   

Address book helps to add an address of recipient for future reference. Instead of 
typing the address again and again this helps to include a recipient address from 

the address book. The process includes following steps.  
Step 1: Go to “Settings” at the top right corner of your web page and from dropdown 

list, select “Settings”.  

  

  
Step 2: Click “Writing email” tab and mark the check box that shows 

“Automatically add new recipients to contacts”, now new addresses get added to 
the contacts or address book.  

  

Sending Softcopy as attachment   

Softcopy is a digital document or a file that is stored in a computer unlike a written 
or printed document like papers or notebooks. Attaching softcopy is similar to that 

of attaching documents to the mail. The steps involved are given below.  
Step 1: Compose mail providing “To” address, “Subject”, “Body” of the message, 

then click on attachment ( ) button and select “Attach files from computer” 
option in order to add softcopy of a document to the mail.  
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Step 2: In the window opened, select document or file you need to send and click 

“Open” button.  

  

  
Step 3: Once the document or file gets attached to mail, click “Send” button to send 

mail to the recipient.  
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Handling SPAM   

Spam is a folder where unwanted or suspected mails get stored.  

Mark emails as spam  

We can mark email as spam using the following steps.  
Step 1: Select the email that you want to move to spam folder and click “Move to” 

option.  

  
  

  

  

  

Step 2: From the displayed menu, click any one of the following options.  

✓ Report Spam - Unwelcomed/uninvited/unsought emails.  

✓ Report a Hacked Account - Emails from the contacts that are not usual or 

normal.  
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✓ Report a Phishing Account - Emails from authorized concern, but are actually 

meant to scam personal information.  

✓ Not my mail - Email addressed to some other person.  

Step 3: Now, when you check the spam folder, you can see the mail that you marked 
as spam is added to the spam folder.  

  
  

Mark emails as not spam  

We can mark emails as not spam using the following steps.  
Step 1: Go to spam folder and mark the mail that you don’t want to be displayed in 

the spam folder.  

   

Step 2: Click “Not spam” option at the top of the page.  
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Step 3: Now go to “Inbox”, you can see the email that you removed from the spam 

folder is shifted to the “Inbox” folder.  
 

Instant Messaging and Collaboration   

 

Instant messaging is real time mutual communication between persons via 
internet. This is a private chat. Once the recipient is online, you can start sending 
messages to him/her. Unlike emails, where you have wait for the reply from the 

recipient, collaboration uses instant messaging technique. This also supports the 
usage of add-on features like smiley or emoticons with the text message. Examples 

of instant messaging applications include Facebook, We Chat, Twitter, LinkedIn, 
etc.  

Using Smiley   

Smileys are otherwise called as emoticons. Emoticons are graphical representation 
of emotions. There are 300+ emoticons in instant messaging. Emoticons are 
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pictorial representation of facial expressions that showcase emotions like 
happiness, sorrow, crying, exclamation, etc.  

Adding Smileys or Emoticons  

To add an emoticon to the message, follow the below steps.  
Step 1: Go to instant messenger and open your chat window.  

  
Step 2: At the bottom of chat window, you can see emoticon symbol, on clicking that, 

a list or group of emoticons is displayed. You can choose the desired emoticon by 

selecting it.   

  

  

Send button  

• As you cannot change anything mail once it is sent, think twice before you hit 

the send button.  

• Check whether you have conveyed everything in a formal language before 

hitting the send button. 
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 and maintaining is management computing Cloud Computing Cloud Prerequisite:
 its of Some hybrid. or private public, it be resources and services cloud the controlling
 deployment capacity, backups, storage, performance, balancing, load include aspects

fu needs personnel managing cloud a so do To etc. 
 

Storage? Cloud is What 

 It Internet. the through service different a as termed is general in Computing Cloud
 storage, data like applications and tools include which resources various has

 infrastructure and platforms, applications, has It etc. networking, servers, databases,
.desktops laptops, servers, by surrounded is which 
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Definition: What is Google Docs? 

 

 

Google Docs is a web-based word-processing application developed by Google. It is part of the 

Google Workspace (formerly known as G Suite) suite of productivity tools, which also includes 

Google Sheets, Google Slides, Google Forms, and Google Drive. 

 

What is 

Google 

Docs? 

Google 

Docs is a 

type 

of word 

processor that is accessed online. With Google Docs, you can make, edit, and save  

documents right in your web browser. These documents are stored in the cloud, which means 

you can access them from any computer with an internet connection. You can use various fonts 

and file formats to create or modify your online documents. You can also work with your 

documents on the go using mobile devices like Android, Chrome, or iOS smartphones and 

tablets. You can even create new documents from your mobile device. 

 

Google Workspace Microsoft 365 

30 GB to 5 TB of storage available, 
depending on plan. Files only 
accessible online. 

1 TB of storage available, 
more with custom plans. 
Files can be used locally or 
via the cloud. 

Better collaboration capability. 
Multiple users can work on the 
same document at the same time, 
and all updates are shown to all 
collaborators in real time. Allows 
viewing, editing, comments, and 
suggestions. 

Collaboration capability is 
fully functional, but it’s 
somewhat more challenging 
to use than Google’s version. 
Allows viewing and editing. 

Customizable, secure email that is 
user-friendly and works well with 
third-party applications. 

More sophisticated email 
options for better 
organization and 
management. Offline 
functionality and significantly 
higher daily email limit. 

Data loss prevention, AI-powered 
security. 

Advanced threat detection 
 
 
 
 

  

https://www.geeksforgeeks.org/word-processing-software/
https://www.geeksforgeeks.org/word-processing-software/
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What is Google Sheets? 

Google Sheets is a web-based application that enables users to create, update 

and modify spreadsheets and share the data online in real time. 

Google's product offers typical spreadsheet features, such as the ability to add, 

delete and sort rows and columns. But unlike other spreadsheet programs, 

Google Sheets also enables multiple geographically dispersed users to 

collaborate on a spreadsheet at the same time and chat through a built-in instant 

messaging program. Users can upload spreadsheets directly from their 

computers or mobile devices. The application saves every change automatically, 

and users can see other users' changes as they are being made. 

 

 

Docs? Google is What 
 developed application processing-word based-web a is Docs Google

 G as known (formerly Workspace Google the of part is It Google. by
 Sheets, Google includes also which tools, productivity of suite Suite)

Drive. Google and Forms, Google Slides, Google 
 

 

What is Google Drive 

in the cloud.  service storage file is a free Google Drive Google
s,Doc Google Launched in 2012 to replace which only had 1GB of 

storage, it meant a wide increase in capacity for users reaching 
completely free. In addition, Google Drive  15GB up to

incorporates several applications such as a spreadsheet  

https://www.techtarget.com/whatis/definition/spreadsheet
https://www.techtarget.com/searchunifiedcommunications/definition/instant-messaging
https://www.techtarget.com/searchunifiedcommunications/definition/instant-messaging
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program, a program to create presentations and a text editing 
program, all 3 very similar to the Microsoft Office package, in this 
case assimilating Microsoft Excel, Microsoft PowerPoint and 
Microsoft Word. 

a video communication service developed by  is  -:MeetGoogle 
Google, primarily used for video conferencing and virtual 
meetings. It allows users to connect with others through video, 
audio, and chat, and also offers features like screen sharing and 
the ability to join meetings via a web browser or mobile 
app. Google Meet is integrated with other Google Workspace 
apps like Gmail and Google Calendar, making it easy to schedule 
and join meetings.  

 

 

 

 

 

 

 

 

Meet:-
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